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1 Document Information 

1.1 Purpose and Scope 

This document provides a step by step description on how to integrate EtherNet/IP and HART devices 

with a Honeywell ControlEdgeTM UOC System. All content of this document is jointly developed, reviewed 

and approved by Honeywell and Endress+Hauser as a common deliverable of Open Integration. 

1.2 Document History 

This is version 1.00.00 of this document. Version history: 

Version Released Description 

1.00.00 2020-11 Initial version 

 

1.3 Related Documents 

Please refer to related documents as listed below: 

Document Description 

SD02648S/04/EN/1.20 Reference Topology HON03 

SD02650S/04/EN/1.20 Integration Test Summary HON03 

SD02651S/04/EN/1.20 List of Tested Devices and Versions HON03 
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2 Pre-Requisites 

Readers of this document should be familiar with related documents as listed in chapter 1.3 and basics on 

how to work with the Honeywell ControlEdgeTM UOC System as well as EtherNet/IP and HART in general. 

Please refer to recommended literature as listed in chapter 2.1. 

2.1 Recommended Literature 

2.1.1 Honeywell 

Please refer to online help of the Honeywell Configuration Studio for latest information about the 

Honeywell control system. 

2.1.2 Endress+Hauser 

Document Description 

BA00065S/04/EN/11.20 FieldCare SFE500 Operating Instructions 

2.1.3 Other 

2.1.3.1 Rockwell Automation 

Document Description 

1783-UM007G-EN-P Stratix Managed Switches 

1783-PC011B-EN-P Ethernet Tap 

2.1.3.2 Festo 

Document Description 

8024075-CPX-FB36-EN Bus node - EtherNet/IP 
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2.2 Operable Control System 

This document assumes an operable Honeywell ControlEdgeTM UOC as defined by Reference Topology 

HON03. Please refer to manuals listed in chapter 2.1.1 for explanation on how to use hard- and software 

provided by Honeywell. 

2.3 Operable Asset Management System 

This document assumes an operable Endress+Hauser FieldCare environment as defined by Reference 

Topology HON03. 

2.4 Operable Field Network Infrastructure 

This document assumes an operable selection of Endress+Hauser EtherNet/IP and HART devices, as 

defined by Reference Topology HON03. Please refer to manuals listed in chapter 2.1.3 for installing of 

hardware and software provided by other parties.  

2.5 Operable Field Devices 

This document assumes an operable selection of Endress+Hauser EtherNet/IP and HART devices, as 

defined by Reference Topology HON03. Each field device is powered if needed and adequately connected 

to the Honeywell ControlEdgeTM UOC System. If required, please refer to individual device manuals for 

further advice. 
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3 Basic Integration 

This chapter describes the main workflow for integrating EtherNet/IP devices into a Honeywell 

ControlEdgeTM UOC and HART devices into a Turck Excom Remote/IO. As a result, the EtherNet/IP cyclic 

communication as well as the 4-20 mA/HART communication are running. Process values and status 

information are available within the control strategy of the system for further processing. 

3.1 IP Network Address Configuration 

All devices in the EtherNet/IP network need a valid IP address. This chapter explains how this can be set 

for the different device types used in this topology. 

3.1.1 IP Address Overview 

The table below lists all IP addresses to configure with the used method: 

 

3.1.2 Proline 300/500 

IP addresses of Endress+Hauser EtherNet/IP devices may be configured directly on the display if available 

or by using the web server. 

This example describes the main steps for configurating the IP address for the Promass 300 by using the 

Web server. Please refer to the device manual for further details. 

• Power off the device. 

 

• Set the device DIP switch 2 to ON in order to select the default IP address 192.168.1.212: 

 

 
 

• Reboot the device.  

Network Configured IP Address Subnet Mask IP Configuration Method

Stratix 5400 10.126.93.20 255.255.255.0 Web server

ETAP 1783 10.126.93.21 255.255.255.0 DIP Switch and BOOTP server

Remote IO Excom 10.126.93.46 255.255.255.0 Turck Service Tool

CPX_FB36 10.126.93.111 255.255.255.0 Festo Field Device Tool

Promag500 10.126.93.112 255.255.255.0 DIP Switch and Web server

Promass300 10.126.93.113 255.255.255.0 DIP Switch and Web server

Component

IO Network

EtherNet/IP 

Field Devices

Switches
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• Connect a laptop with private network settings (192.168.1.1/24) to the Promass300 with an 

Ethernet cable.  

 

• Open a browser and enter the IP address 192.168.1.212: 

 
Enter the default access code “0000” and click on the button Login. 

 

• Click on the button “Menu→Setup→Communication”: 

 
 

• Deactivate the option “DHCP client” and set the new IP address and subnet mask:  
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Remarks 

• Once done, the connection to the Web server is lost. The connection can be reestablished by 

entering the assigned IP address.  

• Reconfigure the DIP switch 2 to OFF. 

3.1.3 CPX FB36 

• Connect a laptop to the Festo CPX network via Network cable and start the Festo software “Field 

Device Tool”: 

 
 

• Connected FB36 adapter is automatically displayed: 

 
 

Click on the menu “Network” to configure the IP settings and click on the button “OK” to save. 
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• Verify as well that the DIL switch 1.1 is configured to OFF (Factory setting operating mode) and 

that the DIL switch 1.2 is OFF for EtherNet/IP network protocol: 

 
 

• In this example, the DIL switch 2 is configured with I/O diagnostics interface, that means switch 

2.1 is on ON and switch 2.2 on OFF: 

 
 

Please refer to the user manual for further details. 

3.1.4 Excom Gateway 

• Connect a laptop to the Excom Remote I/O via network cable and start the Turck software “Turck 

Service Tool”: 

 
 

• Click on the button “Search”: 
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• This displays the found devices: 

 

 
 

• Select the device and click on the button “Change(F2)”: 

 
 

• This displays the “Change device configuration” window. Set a Device name and the device 

network settings: 

 
 

In this example, the IP address is 10.126.93.46 and the subnet mask 255.255.255.0. 

 

• Click on the button “Set in device”. 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 13/120 

 

• Changes have been updated: 

 
 

3.1.5 Stratix 5400 

In this example, the Stratix5400 IP address has been configured by using the “Express Setup”. Please refer 

to the user manual “Stratix Managed Switches” for further details. 

The EtherNet/IP ring is connected between port1 and port2. 

• The Device Level Ring settings (Ports and mode) can be configured by clicking on the menu 

“Configure→DLR”:  

 
 

Remark 

• In this example, the mode is “Node” because the “Supervisor” mode is set in the UOC system. 
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3.1.6 ETAP Modul 

The ETAP module IP settings have been configured by using the Rockwell Automation tool BOOTP server.  

• This requires first to configure the ETAP module DIP switches to following states: 

o DIP Switch 1 configured to OFF, to get the IP address from BOOTP server. 

o DIP Switch 2 configured to ON, to get the IP address from BOOTP server. 

o DIP Switch 3 configured to OFF, to disable the Ring Supervisor mode. 

 

• Connect a Laptop to the Ethernet module 1756-EN2TR with an Ethernet cable and start the tool 

“BOOTP”. 

 

• Click on the menu “Tools→Network Settings”: 

 
 

• Set the subnet mask according to the network, in this example 255.255.255.0 and click on the 

button “OK”: 

 
 

• Select the ETAP MAC address and click on the button “Add to Relation List”: 
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• These opens the window “New Entry”. Enter the MAC address and the requested IP address, then 

click on the button “OK”: 

 
 

• This assigns the IP address: 

 

Please refer to Rockwell Automation Datasheet for further details.  
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3.2 System Configuration 

3.2.1 New Project 

• Start the software Configuration Studio: 

  
 

• Select the menu “SystemName” and click on the button “Connect” (Honeywell EPKS System must 

be connected to the network): 
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3.2.2 System Offline Configuration 

3.2.2.1 Enterprise Model Configuration (Asset Configuration) 

Assets are used to fix the scope of responsibilities in a project. These items are mandatory for Control 

Strategy. This chapter explains how creating Assets. 

• In Configuration Studio, select “SystemName” in the Configuration Explorer and click on the menu 

“Configure Assets for this system”: 

 
 

• The Assets management tool is opened and displays configured assets: 

 
 

• Right-click on “Assets” and select the menu “New ASSET”: 
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• Configure the Asset “Tag Name” and “Item Name”. The parameter “Full Item Name” is refreshed 

automatically. Click on the button “OK”. 

 
 

• New Asset “ControlSystem” has been inserted: 

 
 

• Further relevant assets have been added as well: 
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• Select all created assets and click on the shortcut button “Load Entire Model”: 

 
 

• Click on the button “OK”: 

 
 

• Assets have been successfully loaded. Click on the button “OK”: 

 

 Remark: 

• The asset model can be created as a hierarchy 10 levels deep, with 5 levels of alarm history. 

• There are direct assignable assets and non-direct assignable assets. Direct assignable assets can 

be directly included or excluded from a Scope of Responsibility (SOR) while non-direct assignable 

assets are always following the SOR assignment of its parent.  
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• Updated Assets: 

 

3.2.2.2 IP Network Settings  

The table below lists all IP addresses to configure with the used method: 

 

3.2.2.2.1 Experion PKS Server 

• Select the menu “Control Strategy” and then click on the menu “Configure process control 

strategies”: 

  

Network Component Configured IP Address Subnet Mask IP Configuration Method

Experion PKS Server Server 192.168.12.86 255.255.255.0 ControlBuilder

Control System UOC 192.168.12.21 255.255.255.0 Rotary DIP switch and ControlBuilder

Control System UOC 10.126.93.65 255.255.255.0 ControlBuilder

Stratix 5400 10.126.93.20 255.255.255.0 Web server

ETAP 1783 10.126.93.21 255.255.255.0 DIP Switch and BOOTP server

Remote IO Excom 10.126.93.46 255.255.255.0 Turck Service Tool

CPX_FB36 10.126.93.111 255.255.255.0 Festo Field Device Tool

Promag500 10.126.93.112 255.255.255.0 DIP Switch and Web server

Promass300 10.126.93.113 255.255.255.0 DIP Switch and Web server

Switches

EtherNet/IP 

Field Devices

IO Network

FTE Network



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 21/120 

• This opens the Control Builder environment: 

 

 

• In the toolbar, select the menu “Tools→ System Preferences”: 
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• Select the tab “Embedded FTE” and enable the “Edit network parameters” checkbox: 

 
 

• Edit the network settings according to the corresponding network. 

In this example, following configuration has been set: 

 
 

The IP address of the Primary Server (EPKS Server) is 192.168.12.86. 

 

Click on the button “OK” to continue. 
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• Following message is displayed:  

 
 

Click on the button “OK” and restart other Control Builder running at the system, if required. 

3.2.2.2.2 Control System 

Honeywell ControlEdgeTM Unit Operations Controller has two IP addresses, one related to the FTE network 

another one related to the Downlink network. FTE network must be configured via hardware (rotary DIP 

switch) and software (Control Builder) whereas Downlink network only via software (Control Builder).  

In this example, the FTE network IP address is 192.168.12.021 and the Downlink IP address is 

10.126.93.65. 

Hardware Configuration 

• The last byte of the FTE IP address 192.168.12.021 (which corresponds the FTE device index) 

must be configured with a screwdriver on the rotary switches of the UOC system card. The first 

switch is set to “0”, the second one to “2” and the last one to “1”: 
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Software Configuration 

• In the Project-Assignment view, right-click on “Root” and select the option 

“New→Controllers→UOC – Control Edge Unit Operations Controller”: 

 
 

• This opens the UOC configuration window: 
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• UOC system Tag name, Associated Asset, FTE and Downlink IP addresses have to be configured in 

the tab “Main”: 

 
 

In this example,  

o The TAG Name is “UOC_21” (name referring to the FTE device index). 

o The selected Associated Asset is “ControlSystem” (Associated Asset is an optional setting). 

o The entered Device Index is 21 (index referring to the last byte of the FTE IP address). The 

subnet mask has been defined in chapter 3.2.2.2.1. 

o The configured Downlinked IP address is 10.126.93.65/24.  

 

• Click on the button “ok” to save and close the window. 

3.2.2.3 Device Level Ring Supervisor  

There must be one Ring Supervisor in a Device Level Ring (DLR)network. In this example, the Ring 

Supervisor is the UOC system. 

• In the Project Assignment view, double-click on the UOC_21 controller. 
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• In the tab “Main“, configure the connection Type to “Ring-DLR”: 

 

Remark: 

The Connection Type mode can only be modified if the UOC system is stopped. A connection type 

change requires a system Restart as well, which has to be performed in Online Monitoring by 

selecting the Module Command option “RESTART”: 
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• Click on the tab “Downlink”, scroll down and check the DLR configuration. In this example, the DLR 

ring role is configured as “Supervisor”: 

 
 

Remark: 

If the UOC system would not be the DLR Supervisor, then the Role would have to be configured to 

“Member”: 

 
 

• Click on the button “OK” to set the configuration. 

 

• The UOC system is successfully inserted in the project: 

 
 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 28/120 

• Expand the “UOC_21” menu and rename all modules for a better overview: 

     
 

• Download the configuration in the system. Please refer to chapter 3.6.1.1 to proceed. 

 

3.3 Excom Remote I/O Integration  

This part describes the configuration of the Turck Remote I/O (Gateway and IO modules) in Control 

Builder. 

3.3.1 Control Builder Field Device Library 

• The Excom components are part of the Honeywell library: 

 
 

• An additional EtherNet/IP adapter must be used as well: 
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3.3.2 Excom Remote I/O Configuration 

This chapter describes the steps to configure the gateway and IO modules of the Turck Remote I/O. There 

are two methods to configure the Excom Remote IO, either via Web or via ControlBuilder. The 

configuration via ControlBuilder is recommended and described in this chapter. 

3.3.2.1 Ethernet Gateway GEN Adapter 

• The generic adapter “GENADADAPTER” from the library “ETHERNET_IP” is used to configure the 

GEN-N gateway. Drag and drop the module “GENADAPTER” from the library “ETHERNET_IP” on 

“CEEUOC_21”: 

  
 

• Following window is displayed: 

 
Change the Destination name, for example “EXCOM” and click on the button “Finish”.  
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• Adapter is inserted in the project: 

 
 

• Double-click on the adapter. 

 

• This displays following window: 

 
 

Configure the IP address of the bus controller as well as the backplane Chassis size.  

In this example, the IP address is 10.126.93.46 and the chassis size is 25. Please note that chassis 

size equals No. of IO modules plus 1: 
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The used backplane is a MT24-N, which can connect until 24 IO modules as described on 

following picture: 

 

 

 
The chassis size corresponds to the number of available slots in the backplane plus the gateway, 

that means 24+1= 25. 

 

• Click on the button “OK”. 

  

Redundant gateways Slot 1 to 24 
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3.3.2.2 Ethernet Gateway GEN 

• Drag and drop the gateway module “GEN2” from the library “EXCOM” on the gateway adapter 

“EXCOM”: 

 
 

• Following window is displayed: 

 
 

• Change the Destination name, for example “SLOT0_GEN” and click on the button “Finish”. 
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• Gateway is inserted in the project: 

 
 

• Double-click on the adapter. 

 

• This displays following window: 

 
EtherNet/IP communication RPI time can be updated here if needed. Default time is 100ms. 

 

• Click on the tab “Configuration” to configure the gateway options “Line frequency”, “CAN 

redundancy” and “Power supply”: 
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• Click on the tab “Advanced Configuration / Statistics” and select the option “Route Slot 0 

connection through backplane”: 

 
 

• Click on the button OK.  
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3.3.2.3 Analog Input Module HART AIH40  

Different AIH40 templates are available depending on the needed configuration (with or without HART 

variables). In this example, we have chosen the template “AIH40_4_20MA_8H”, which allows the user to 

configure until 8 HART variables for the 4 channels. 

• Drag and drop the module “AIH40_4_20MA_8H” from the library “EXCOM” on the Ethernet 

adapter “EXCOM”: 
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• Following window is displayed: 

 
 

• Change the Destination name, for example “SLOT1_AIH40_4_20MA_8H” and click on the button 

“Finish”. 

 

• Analog Input Module is inserted in the project: 

 
 

Double-click on the analog input card. 
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• This displays following window: 

 
 

In the tab “Main”, configure the parameter “Module slot number in chassis”. In this example, the 

card is this one plugged in Slot1. 

 

• Click on the “Channel Configuration” to configure the different channel options: 
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• Scroll to the right to see the HART data SV, TV an QV: 

 
 

In this example, channel 1 has been configured with the four HART data. The card 

“AIH40_4_20MA_8H” allows the configuration of maximal eight HART data. In consequence, all 

four channels cannot be configured with their four HART data. 

 

• Select the tab “Advanced Configuration / Statistics” and choose the option “Refresh Connections on 

Switchover”: 

 
 

Click on the button “OK”. 
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• Additional Analog Input cards have been added in our application: 
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3.3.2.4 Analog Output Module HART AOH40  

As for the analog input cards, there are as well different AOH40 templates depending on the needed 

configuration (with or without HART variables). In this example, we have chosen the template 

“AOH40_4_20MA_8H”, which allows the user to configure until 8 HART variables for the 4 channels. 

• Drag and drop the module “AOH40_4_20MA_8H” from the library “EXCOM” on the Ethernet 

adapter “EXCOM”: 

 
 

• Following window is displayed: 

 
 

• Change the Destination name, for example “SLOT5_AOH40_4_20MA_8H” and click on the button 

“Finish”. 
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• Analog Output Module is inserted in the project: 

 
 

Double-click on the adapter. 

 

• This displays following window: 

 
 

In the tab “Main”, configure the parameter “Module slot number in chassis”. In this example, the 

card is this one plugged in Slot5. 

 

• Download the configuration in the system. Please refer to chapter 3.6.1.2 to proceed.  
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3.4 EtherNet/IP Field Device Integration 

3.4.1 CPX MPA Valve Island  

This part describes the configuration of the Festo Valve island (Gateway and pneumatic modules). 

3.4.1.1 Control Builder Field Device Library 

• The Festo components are part of the Honeywell library: 

 
 

• An additional EtherNet/IP adapter must be used as well: 

 

3.4.1.2 CPX MPA Valve Island Configuration 

3.4.1.2.1 Gateway GEN Adapter 

• The generic adapter “GENADADAPTER” from the library “ETHERNET_IP” is used to configure part 

of the FB36 gateway. Drag and drop the module “GENADAPTER” from the library “ETHERNET_IP” 

on “CEEUOC_21”: 
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• Following window is displayed: 

 
Change the Destination name, for example “CPX” and click on the button “Finish”. 

 

• Adapter is inserted in the project: 

 
 

Double-click on the adapter. 
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• This displays following window: 

 
 

In the tab “Main”, enable the parameter “Consolidate Connections” and configure the IP address of 

the bus controller as well the backplane Chassis size. In this example, the IP address is 

10.126.93.111 and the chassis size is 2. 

 

In this example, the chassis is composed of two slots: the FB36 and MPA1S-D modules: 
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• Select the tab “Assembly Configurations”, “Connection Parameters” and “Slot Assembly Map” must 

be defined: 

 
 

These parameters can be found in the library “FESTO_CPX” as described below. 

Connection Parameters 

• In the library “FESTO_CPX”, double-click on “FB36” and select the tab “Assemblies” to display the 

“FB36” assemblies: 

 
 

• In the library “FESTO_CPX”, double -click on “VMPA1S_D” and select the tab “Assemblies” to 

display the “VMPA1S_D” assemblies: 
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• The “Assembly Instance” parameters are the same for both modules (Config: 102, Input:101, 

Output:100). The “Assembly Instance Size (Bytes)” parameters are the sum result of “FB36” and 

“VMPA1S_D” (Config: 0+0=0, Input: 2+0=2, Output: 2+1=3): 

 
 

Slot Assembly Map 

• The “Slot Assembly Map” corresponds to the Input/Output data size Offset and Size. The “Slot 

Assembly Map” is depending on the Hardware configuration.  

In this example, the chassis size is two, one slot the FB36 module and another one for the 

VMPA1S_D module. 

 

• In the library “FESTO_CPX”, double -click on “FB36”. Select the tab “Assemblies” and click on the 

button of the Input “Assembly Members”: 

 
 

• This displays the Inputs settings of the FB36 module, 16 bits for that example: 

 
 

• Click on the button of the Input “Assembly Members”: 
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• This displays the Outputs settings of the “FB36” module, 16 bits for that example: 

 
 

• In the library “FESTO_CPX”, double -click on “VMPA1S_D” and select the tab “Assemblies” to 

display the “VMPA1S_D” assemblies. Then click on the button in the “Assembly Members”: 

 
 

• This displays the Outputs settings of the “VMPA1S _D” module, 8 bits for that example: 

 
 

• Report the previous values in the Slot Assembly Map: 
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3.4.1.2.2 Bus node FB36 

• Drag and drop the module “FB36” from the library “FESTO_CPX” on the Ethernet adapeter “CPX”: 

  
 

• Following window is displayed: 

 
 

Change the Destination name, for example “SLOT_0_FB36” and click on the button “Finish”.  
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• Adapter is inserted in the project: 

 
 

• Double-click on the Bus node. 

 

• This displays following window: 

 
 

Verify the parameters “IP address of the device” and “Module slot number in chassis”. Then click on 

the button “OK”. 
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3.4.1.2.3 Pneumatic Module MPA1S 

This part describes the configuration of the MPA1S pneumatic module, which can control up to 8 digital 

output channels. 

• Drag and drop the module “VMPA1S” from the library “FESTO_CPX” on the Ethernet adapeter 

“CPX”: 

  
 

• Following window is displayed: 

 
 

Change the Destination name, for example “Slot_1_VMPA1S_D” and click on the button “Finish”.  
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• Module is inserted in the project: 

 
 

• Double-click on the Bus node. 

 

• This displays following window: 

 
 

In the tab “Main”, verify the parameter “IP address of the device” then configure the parameter 

“Module slot number in chassis”. In this example, the IP address is 10.126.93.111 and the slot 

number is 1. 
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• Click on the tab “Channel Configuration” to configure the solenoid channels:

 
• Click on the list box of “Spare01” and select the item “DO”: 

 
• In this example, a digital Output “DO” is now defined for the solenoid 0: 

 
Click on the button “OK”.  
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• Download the configuration in the system. Please refer to chapter 3.6.1.3 to proceed. 

3.4.2 Promass 300 Flowmeter 

3.4.2.1 ODVA Tool for EDS File Reading 

The EDS file contains the list of relevant device parameters. This file can be opened either with a standard 

Text editor or much more convenient by using the ODVA tool EZ-EDS. This tool can be downloaded on 

https://www.odva.org/ The following example is done with EZ-EDS. 

• Start the software EZEDS.exe: 

  
 

• Select the menu “File→Open…”: 

 
 

• Select the EDS file, for example “Promass300_5000101.eds” and click on the button “Open”: 

 
 

  

https://www.odva.org/
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• Select the format “EtherNet/IP EDS” and click on the button “OK”: 

 
• Main Parts are listed on the left side: 

 
For example, the available Promass300 connections types are part of “Connection Manager”  
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3.4.2.2 Control Builder Field Device Library 

• The following window displays the Promass300 device in the Honeywell Library. All possible 

device connections are available:  

 
 

 

  

Connection “103B_100_CO”: 

• “103B” corresponds to the Promass300 device 

type. 

• “100” corresponds to the Assembly FixIn: 

 
• “_CO”  

o “C” is for “Configuration” 

o “O” is for “Output” 

The connection “103B_100_CO” corresponds to 

“FixIn+Output+Configuration Assembly”. 
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3.4.2.3 Device Configuration with Connection FixIN + FixOut + Config 

• Drag and drop the Promass300 FixIn+Output+Config “103B_100_CO” from the library 

“EH_PROMASS_300_500_0101” on “CEEUOC_21”: 

  
 

• Following window is displayed: 

 
 

Change the Destination name, for example “PROMASS300” and click on the button “Finish”.  
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• Device is inserted in the project: 

 
 

• Double-click on the device. 

 

• This displays following window: 

 
 

In the tab “Main”, configure the IP address of the device. In this example, the IP address is 

10.126.93.113. 
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• Connection types with “Config” as for example “FixIn+Output+Config” contains some configurable 

parameters. Click on the tab “Configuration”:

 
 

The main Promass300 configurable parameters in this section are: 

o Write Protection 

o Sensor Adjustment 

o System Units 

o Totalizers 

o Configurable Input Assembly 

o Low Flow Cut Off 

o Process Parameters 

o Diagnostics Behavior 

o Partially Filled Pipe Detection 

o Compensations 

o Concentration 

o Petroleum Mode 

 

These parameters will be downloaded into the device during the Download. 
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• Be careful by the configuration of the Totalizer PV. Don’t forget to update the corresponding Unit 

as well. Otherwise the communication with the device will not be successful after the download: 

 
 

• Click on the tab “Alarm” to see the Alarm configuration. These alarms have been defined with their 

default values in the device connection template: 

 
 

The alarm list for Endress+Hauser Ethernet/IP field devices contains the Namur NE107 status 

signal diagnostics. Settings as “Priority” or “Severity” can be configured. 

 

• Download the configuration in the system. Please refer to chapter 0 to proceed. 
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3.5 Control Strategy 

3.5.1 Analog Input Function Block Configuration 

This chapter explains how assign analog input function blocks. The method is the same for mapping 

analog inputs from HART or EtherNet/IP field devices.  

3.5.1.1 New Control Module 

• Right-click on the field “Root” and select the option “New→Control Module”: 

 
 

• The created Control Module is automatically opened and saved under “Unassigned”: 
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• Close the Control Module. 

 

• Rename the Control Module, for example “CM_EXCOM_AIH40_SLOT1_Ch0”: 

 
 

• Drag and drop the Control Module in “CEEUOC_21”: 

  
 

• Right-click on the Control Module and select the menu “Module Properties…”: 
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• Click on the shortcut button “Parent Asset#”: 

 
 

• Select a “Parent Asset” and click on the button “OK”: 

 
 

In this example, the Parent Asset is “RemoteIO”. 

 

• Asset is assigned. Click on the button “OK” to close the window: 
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3.5.1.2 New IO Point 

• Right-click on “AI” in the “IOPOINTS” project library and select the menu “Instantiate”: 

 
 

• This displays following window: 
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• Select the IOPOINT Attributes “IOPOINT_PARAM”: 

 
 

• Click on the shortcut button “Associated IOM or Parameter”: 

 
 

• Select the Point Name and then the Parameter. 

 
 

In this example, the selected parameter is the Ch0 Raw Process value (“PVRAW[0]”) of the first 

Excom Analog Input value. 
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• Click on the button “OK”. 

 

• Rename the Tag Name as well and click on the button “OK”: 

 
 

• The created IOPOINT appears under the defined allocation: 
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3.5.1.3 IO Point Assignment 

• Open the Control Module “CM_Excom_AIH40_SLOT1_Ch0”, then Drag and drop the AIREF 

component from the IOREFERENCES library: 

 
 

• Double-click on the AIREFA function block: 
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• Click on the shortcut button “Reference”: 

 
 

• Select the IOPOINT created previously and click on the button “OK”: 
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• Reference is assigned. Click on the button “OK”: 

 
 

• The analog input function block is now configured for the current value of EXCOM SLOT1 CH0 

card: 

 
• Proceed as well for other relevant device data: 
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• In this example, four additional AI IOPOINTS have been created for the EXCOM SLOT1 Channel0 

card and mapped to an AIREF IOREFERENCE block: 

 
• Control module must be closed to create the AI IOPOINTS. 

Remark 

• The method is the same to map analog inputs values from other devices as for example the 

Promass300 EtherNet/IP, ie create an Instance of an “AI”, assign the IO point parameter and link it 

to an analog input reference: 
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• In following example, a new Control Module for the Promass300 (CM_PROMASS300) has been 

created, in which are mapped Density, Mass flow, Temperature and totalizers process values: 

 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 71/120 

3.5.2 Digital Output Function Block Configuration 

This chapter explains how assign digital output function blocks. 

3.5.2.1 New Control Module 

• Create a new Control Module for the CPX Valve Island as done in chapter 3.5.1.1: 

 
 

3.5.2.2 IO Point Assignment 

• Open the Control Module “CM_CPX”, then Drag and drop the DOREF component from the 

IOREFERENCES library: 
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• Double-click on the DO function block: 

 
• Select the Reference Type “IOPOINT_PARAM”: 

 
 

• Click on the Reference parameter shortcut: 
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• Select the Digital Output DO_01: 

 
 

• Reference is set. Click on the button “OK”: 

 
 

• DO reference block is configured: 
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Remark: 

• The Reference “DO_01” has been configured in chapter 3.4.1.2.3: 

   
 

• In the UTILITY library, drag and drop the function block “FLAG”: 
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• Connect both function blocks: 

 

3.5.3 Control Strategy Download  

• Please refer to chapter 3.6.2 for the Control Module Download.  
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3.6 Commissioning of the Control Project  

3.6.1 Configuration Download 

3.6.1.1 UOC system  

• In the project assignment view, select the UOC system and click on the shortcut button “Load” in 

the tool bar menu: 

 
 

• This opens the “Load Operation” window. Select the option “Change state to Post-Load State after 

load” and click on the button “Load”: 
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• Download is successful. Right-click on “CEEUOC_21” and click on “Change State…”: 

 
 

• Select the option “COLD START”: 

 
 

• Click on the button “Yes”: 

 
 

• Click on the button “OK” to close the window: 
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• UOC system is now activated: 

 

3.6.1.2 Excom Remote I/O  

• In the project assignment view, select the Excom RemoteIO and click on the shortcut button “Load” 

in the tool bar menu: 

  
 

• This opens the “Load Operation” window. Select the option “Change state to Post-Load State after 

load” and click on the button “Load”: 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 79/120 

• Excom Remote I/O is now activated: 

 
 

• The defined channel has still not been downloaded. Select the channel and download it: 

   

3.6.1.3 CPX Valve Island 

• In the project assignment view, select the CPX valve island and click on the shortcut button “Load” 

in the tool bar menu: 

 
 

• This opens the “Load Operation” window. Select the option “Change state to Post-Load State after 

load” and click on the button “Load”: 
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• Festo CPX is now activated: 
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3.6.1.4 Promass300 Flowmeter  

• In the project assignment view, select the UOC system and click on the shortcut button “Load” in 

the tool bar menu: 

 
 

• This opens the “Load Operation” window. Select the option “Change state to Post-Load State after 

load” and click on the button “Load”: 
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• Promass300 Flowmeter is now activated: 

 

3.6.2 Control Module Download 

• Select all created Control modules and click on the button “Download”: 
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• This opens the “Load Operation” window. Select the option “Change state to Post-Load State after 

load” and click on the button “Load”: 

 
 

• Control Modules have been successfully loaded: 
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3.7 Monitoring of Process Values and Status Information 

3.7.1 Control Strategy Online Values  

3.7.1.1 Remote I/O Analog Input Module HART AIH40 

• Double-click on the Control Module “CM_EXCOM_AIH40_SLOT1_CH0”: 

 
 

• Configured analog input process values of the AIH40 card are displayed: 
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3.7.1.2 Promass300 Flowmeter 

• Double-click on the Control Module “CM_Promass300”: 

 
 

• Configured analog input process values of the AIH40 card are displayed: 

 

3.7.1.3 CPX Valve Island 

• Double-click on the Control Module “CM_EXCOM_AIH40_SLOT1_CH0”: 

 
 

• Configured digital output process values of the valve island card are displayed: 
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• Double-click on the parameter PV: 

 
 

• This displays following window: 

 
 

• Select the Actual State “ON” and click on the button “Yes”: 

 
 

• Digital Output is now active: 
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3.7.2 Online Monitoring Values 

3.7.2.1 Supervisor Mode 

• In the Project Assignment monitoring view, double-click on the UOC system “UOC_21”: 

 
 

• Select the tab “Downlink” and scroll down to the DLR status part: 

 
 

In this example, we can see that the active supervisor has the IP address 10.26.93.65, which 

corresponds to the UOC system Downlink IP address. 
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Remark 

• DLR and Downlink Status are displayed in case of any issues 

 
 

In this example, the ETH4 port has been disconnected from the UOC system, which simulates a 

failure. As a consequence: 

o The counter “DLR Ring Fault Count” is incremented. 

o The Downlink Status “ETH4 Failed” is enabled. 

o The Downlink Status “DLR Ring Fault” is enabled. 
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3.7.2.2 TrustSens HART TM371 

• Double-click on “Slot1_AIH40_4_20MA_8H”: 

 
 

• AIH40 Slot 1 analog input card are displayed in the tab Data/Status”: 

 
 

o In this example, Channel PV Raw value 14398 is the TrustSens PV raw value (4mA→0 and 

20mA→40000), which corresponds to 19.99%(4mA→0% and 20mA→100%). 

o HART variable 1 corresponds to the TrustSens Temperature measurement 

o HART variable 2 corresponds to the TrustSens Device temperature 

o HART variable 3 corresponds to the TrustSens number of self-calibrations 

o HART variable 4 corresponds to the TrustSens deviation value  
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Remark 

• Slot1 AIH40 card channel 0 HART data PV, SV, TV and QV have been previously configured in 

chapter3.3.2.3. 

3.7.2.3 Promass300 Flowmeter 

• Double-click on the Control Module “CM_Promass300”: 

 

3.7.2.3.1 Data/Status 

• Click on the tab “Data/Status”, online values of the connection “FixIn+Output+Config” are 

displayed: 

 
 

NAMUR NE107 status and device Diagnostic number are displayed as well.  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 91/120 

3.7.2.3.2 Data/Command 

• Click on the tab “Data/Command”, online values of the connection “FixIn+Output+Config” are 

displayed: 

 
 

• The Data/Command window contains default values. These values correspond to parameters 

enumeration attributes. Please refer to the EDS file for further details. For example, the parameter 

“EU of external process pressure” has the value “4871”: 

 
 

• In the EDS file (opened with EZ-Tool), select the parameter “Param21092” and click on the button 

“Enumerate”. This displays the different values that can be configured for this parameter.  

 
 

In this example, “4871” corresponds to the unit “bar”.  
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3.7.2.3.3 Heartbeat Verification 

• If the option is enabled in the field device, a Heartbeat verification can be performed from the 

Data/Command window with this connection type. Two parameters are required to start the 

verification: “Start Verification Activation” and “Start Verification (encoded)”: 

  
 

Both parameters can be found in the EDS file.  

 

• The parameter “Start Verification“ is Param43 according to the EDS file: 
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• Select the parameter “Param43” and click on the button “Enumerate”. This displays the different 

values that can be configured for this parameter. The “Param43”value must set to “-32378”. 

 

• The trigger bit “Start verification activation” is the parameter “Param20603. Select the parameter 

“Param20603” and click on the button “Enumerate”. This displays the different values that can be 

configured for this parameter: 

 
 

Steps to perform a Heartbeat verification from the Data/Command window 

1. Set the bit “Start verification Activation” and click on the button “Yes”: 

 
 

2. Edit the variable “Start verification (encoded)” to the value “-32378” and click on “Yes”: 

 
 

3. Reset the bit “Start verification Activation”: 
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• NAMUR status and diagnostic number are indicated in the Data/Status tab during the Heartbeat 

verification: 

 

The event 302 means “Device Verification active”. 

3.7.2.3.4 Totalizer Handling 

• Totalizers can be controlled as well from the Data/Command window with the parameters 

“Control Totalizer X Activation” and “Control totalizer value X”: 

 
 

Both parameters can be found in the EDS file.  

 

• The parameter “Control Totalizer 1 Activation “ is Param20600 according to the EDS file: 
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• The parameter “Control Totalizer 1 Activation “ is Param20600 according to the EDS file: 

 
 

This parameter can be configured with six different values. 

Steps to perform a totalizer “Reset+totalize” from the Data/Command window 

1. Edit the variable “Control totalizer value 1” to the value “-32378” and click on “Yes”: 

 
 

2. Set the bit “Control Totalizer 1 Activation” and click on the button “Yes”: 
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3. Reset the bit “Start verification Activation”: 

 
 

• Totalizer value has been reset and starts again to count: 

 
 

3.7.2.4 CPX Valve Island 

• Double-click on “Slot1_VMPA1S”: 

 
 

• Click on the tab Data/Status to display the current status of the solenoid module: 

 
 

In this example, Ch0 is active. 
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4 Advanced Integration 

This chapter describes another method to access the field devices HART data, based on HART over CIP 

protocol. 

Pay attention that the use of this feature does not allow parallel access with a Plant Asset Management 

tool like FieldCare. 

4.1 Offline Configuration 

4.1.1 Channel Assignment 

• In the project view, expand the analog input module, right-click for example on the Channel 1 

Spare module and select the menu “Channel Type Setting→AI”: 

 
 

• A gray symbol is displayed on Channel 1, this indicates that an “AI” is instanced: 
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• In the tab “main”, select the option “Enable HART” and click on the button “OK”: 

 

4.1.2 Field Device Configuration 

• Click on the tab “HART Configuration”: 

 
 

Per default, the Generic HART Device Template is selected. If the device DD is installed, then the 

corresponding template can be selected. This will provide the user a better overview of the field 

device status (HART CMD48). 
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• On the Experion station, start with Administration rights the application “Device Description 

Manager” (located in All Honeywell tools→Engineering Tools) 

 
 

• Uncheck the box, write the Password and click on the button “OK”: 

 
 

• Click on the button “Browse”, select the DD file to import and click on the button “Add/Update 

Device”: 

 
 

In this example, the TrustSens DD file has been selected. 

 

• Select the device type “Analog Input” for the TrustSens and click on the button “OK” 
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• This display following menu: 

 
 

Each CMD48 bit position can be configured as “View Only”, “Event” or “Alarm”. Per default, all 

notifications are set to “Event”. 

 

• Click on the button “OK” to continue. 

 

• DD file has been successfully imported 
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• Go back in ControlBuilder and click on the shortcut button to select another field device template: 

 
 

• Select the needed field device DD template, in our example the TrustSens one (installed 

previously), and click on the button “OK”: 

 
 

• TrustSens template is selected: 
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• Click on the tab “HART Variables” : 

 
 

Click on the list box to select the channel timing parameter of the “Scan HART Variables”. 

 

• Click on the tab “HART Notifications” to display the field device CMD48 text messages: 

 

The configured notification “Event” can be updated to “View Only” or “Alarm” according to the 

project requirements. 

• Click on the button “OK” to save the configuration. 
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• This updates the project view: 

 

4.1.3 Configuration Download 

• Download the configuration in the system. Please refer to chapter 3.6.1.2 to proceed. 

4.2 Online Monitoring 

• Double-click on the channel “S1CH1_TRUSTSENS”: 
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4.2.1 HART Configuration 

• Select the tab “HART Configuration” to get information about the field device tags and ranges: 

 
 

In this example, the parameter “Tag” corresponds to the TrustSens Short Tag (“H_ST)”. 

4.2.2 HART Device Status 

• Click on the tab “HART Device Status” to display device and device specific status: 

 
 

In this example ,there is one message displayed regarding the wrong Device Type. This is a bug in 

ControlBuilder, only for HART7 field devices. This error does not occur with HART5, HART6 field 

devices or by using the Generic HART template. Refer to the tab “HART Identification” for more 

details. 
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• By Simulating an error on the TrustSens, for example “Sensor defective”, status are updated with 

the corresponding message thanks to the field device HART Template: 

 
 

• By using the Generic HART Template, status messages would look like as below: 
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• As the generic HART template is a standard template for all kind of HART field devices, the 

corresponding field device specific status are not decoded with text. 

4.2.3 HART Identification 

• Click on the tab “HART Identification”: 

 

This tab displays information about the configured and the connected HART field device. 

• As explained before, HART7 field device type are not displayed as it should be, and this activates 

unfortunately the bit “Device Type Mismatch”.  

In this example, the offline device type(4559)10 = (0x11CF)16 is the correct device type and it does 

not match with the online device type (207)10 = (0x00CF)16. (which is the HART5 and HART6 

format) 

 

This issue has been sent to Honeywell development and will be fixed soon. 
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• As just explained, HART5 and HART6 field devices are not concerned. For example, following 

picture displays the Deltapilot M (HART6 field device) HART Identification tab, in which the offline 

device Type is matching with Online one: 

 
 

4.2.4 HART Variables 

• Click on the tab “HART Variables” to display the field device HART variables PV, SV, TV and QV: 

 
o The PV variable corresponds to the TrustSens Temperature measurement 

o The SV variable corresponds to the TrustSens Device temperature 

o The TV variable corresponds to the TrustSens number of self-calibrations 

o The QV variable corresponds to the TrustSens deviation value  
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5 Specific Integration 

The Honeywell system provides some features to access to field device specific data. This chapter resumes 

some of them, whose links refers to the previous Basic and Advanced Integration chapters. 

5.1 TrustSens Integration 

Method 1 

This method is based on utilizing the channel HART Data PV, SV, TV and QV of the HART analog input 

module, on which the TrustSens is connected. The TrustSens calibration counter and the deviation value 

are transferred as TV and QV and monitored by the controller. 

Please refer to following chapters for more details: 

• Offline configuration: Chapter 3.3.2.3  

• Offline control strategy configuration: Chapter 3.5.1. 

• Online Monitoring: Chapter 3.7.2.2 

Method 2 

This method uses the HART over CIP protocol to access the TrustSens HART data. Again, the TrustSens 

calibration counter and the deviation value are transferred as TV and QV and monitored by the controller. 

In addition, this method allows to read further information about the HART field device like Tag, 

descriptor, Range and units, CMD48 status, HART identification parameters. The backdrop of this method 

is that the Plant Asset Management tools cannot be used in parallel. 

Please refer to Chapter 4 for more details. 

5.2 Field Device Status 

Please refer to Chapter 3.7.2.3.1 for EtherNet/IP field devices. 

Please refer to Chapter 4 for HART field devices. 

5.3 Heartbeat Verification 

In this tutorial, the described example concerns the Promass300 E/IP. Please refer to chapter 3.7.2.3.3. 

5.4 Totalizer Handling  

In this tutorial, the described example concerns the Promass300 E/IP. Please refer to chapter 3.7.2.3.4. 
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6 Bypassed Tool Integration 

This chapter describes the main workflow for integration of EtherNet/IP and HART devices to the 

Endress+Hauser Plant Asset Management (PAM system) by means of Communication DTMs.  

6.1 FieldCare Configuration 

• Start the application FieldCare: 

 
 

• Select “Create Project” and click on the button “Open”: 

 

 

6.1.1 HART Field Device Connection with Excom Remote I/O 

This chapter describes the TURCK Excom Remote I/O configuration workflow as required to connect with 

HART DeviceDTMs. 

Please note that the Remote IO does not support concurrent access with HART Channel IO points in 

ControlBuilder and HART deviceDTMs in FieldCare. If HART Channel IO points are assigned to analog 

input channels with the option “HART enabled”, as described in chapter 44.1.1, then it will not be possible 

to connect with DeviceDTMs via the same analog input module. The following steps describe the use case 

when no HART Channel IO points are assigned to an analog input module:  
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• Right-click on the Network Tag “Host PC” and select the menu ”Add Device…”: 

 
 

• Select the CommDTM “BL Service Ethernet” from Turck and click on the button “OK”: 

 
 

• CommDTM is inserted in the project view: 

 
 

• Right-click on CommDTM and select the menu “Add Device…”: 
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• Select the CommDTM “excom GEN-N” and click on the button “OK”: 

 
 

• Following windows is displayed: 

 
 

Configure the Gateway IP address and click on the button “OK” 

 

• “Excom GEN-N” CommDTM is successfully inserted in the project: 
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• Select the CommDTM “Excom GEN-N” and click on the shortcut button “Create Network”: 

 
 

• Excom Remote I/O HART cards are scanned and added in the project: 

 
 

• Select for example the analog input card on Slot1 and click on the shortcut button “Create 

Network”: 
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• Select the HART analog input card channels which have to be scanned: 

 
 

In this example, the four channels will be scanned. 

 

• Device has been successfully added in the project view: 

 
 

• The HART field device, a TMT371 can be now connected in Online mode: 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 114/120 

6.1.2 EtherNet/IP Field Device Connection 

This chapter describes the Schneider Electric EIP ComDTM configuration workflow in order to connect 

Endress+Hauser EtherNet/IP Field Devices DTMs. 

• Select the item “Host PC” and click on the shortcut button “Add Device…”: 

 
 

• Select the ComDTM “EtherNet/IP Comm Adapter” from Schneider Electric: 

 
 

• The ComDTM “EtherNet/IP Comm Adapter” is successfully inserted in the project: 
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• Double-click on the ComDTM “EtherNet/IP Comm Adapter”: 

 
 

• Select the tab “Scan” and configure the IP range that must be scanned and click on the button 

“Apply”: 

 
 

• Click on the button “OK:” 
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• Select the ComDTM “EtherNet/IP Comm Adapter”and click on the shortcut button “Create 

Network:” 

 
 

• Following windows appears: 

 
 

There are no deviceDTM for the CPX valve Island installed. That’s why the device status is “6” and 

action is has been configured to  “Do not add to project”. 

 

• EtherNet/IP devices have been successfully added in the project view: 
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• Field device DTM can now be connected for further processing: 

 

6.2 Connection with Web Server 

This chapter describes how to access the Endress+Hauser EtherNet/IP devices by using the integrated 

device Web server for device configuration.  

The Web server feature can only be used if the function “Web server” is enabled in the device (Menu 

“Expert→Communication→Web server”). 

• Open a Web browser and enter the device IP address: 

 
 

In this example, the IP address 192.168.1.113 corresponds to the Promass300. 
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• Device Web server is opened: 

 
 

• Enter the user level code “0000” and click on the button “Login”: 

 
 

• This directly opens the Instrument health status window: 

  



 

 

 Integration Tutorial HON03 Version 1.00.00 
 

SD02649S/04/EN/01.20 119/120 

• This interface allows to access to the same device menu structure (Operation, Setup, Diagnostics, 

as this displayed on the device display or in the deviceDTM: 

 
 

• Click for example on “Setup→System units” to configure device units: 
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